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C H A P T E R

1

Welcome to the Sammi ADK
Sammi is the premier Dynamic Data Visualization Tool (DDVT) offering simple and
efficient development, testing, and maintenance of graphical applications for both X
Windows and Microsoft Windows. Sammi’s advanced architecture is ideal for realtime command and control systems as well as mission-critical client/server
applications demanding high performance. In addition to being a rich graphical
development tool, Sammi gives you the ability to integrate applications distributed
throughout a network without writing any Graphical User Interface (GUI) or network
code.

The Concept is Simple:
Build displays with our “Studio Editor” which works like a drawing
package. Draw your own dynamic objects, import DXF files or simply
choose from the palette of pre-built dynamic objects such as: meters,
gauges, graphs, literal/symbolic displays, menus and buttons.
Connect these building blocks to “live” data from databases, on-line
instruments or other applications on your network, using our standard
Application Programming Interface (API) functions for handling
communications between Sammi and remote data sources.
During runtime, the Sammi Runtime manages commands, events, and data
between users, the GUI, and your peer-to-peer or client/server
applications. In addition, the Runtime handles panning, and zooming of
the displays.
The result is a live graphical display updated in real-time.

Sammi Components:
The Sammi Application Development kit consists of three components:
1. Runtime Environment: A framework with which users interact at runtime.
2. Studio Editor: A tool for creating window for a Graphical User Interface.
3. Application Programming Interface: A library of standard functions for
handling communications between the Runtime Environment and remote
applications.

The diagram on the next page graphically shows the relationship of these three
components. In general, a developer would use the Studio Editor to design displays, a
programmer would use the API to link data to the displays, and the end user would
use the Runtime to view the displays with real-time, dynamic data updates.
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Where to Next?
The next step is to install the Sammi product. Chapter 2 will lead you through this procedure. After
installation you may proceed to Chapter 3 for a self-guided tour or move on to Chapter 4 to begin
hands on tutorials.
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C H A P T E R 2

Installation
Note: Installation instructions can be found in the “Installation Guide”.

Where to Next?
This completes the installation of the Sammi product. Chapter 3, A Quick Tour of
Sammi, will provide instructions on how to start a self-guided, interactive demo that
gives an overview of Sammi including examples of industry applications. If you want
to immediately learn to build displays, proceed directly to Chapter 4.
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C H A P T E R 3

A Quick Tour of Sammi
Provided with the Sammi installation is an interactive demo that explains the Sammi
architecture and features. Also included are several examples of actual industry
applications. Complete the following steps to run the demo.
To start the Runtime Environment

If using a WindowsNT system:
1. Double click on the Sammi icon in the Program Manager (WinNT 3.51) or
select from Start/Programs selection list (WinNT 4.0).
After a brief pause, the Runtime Logon Window will appear.

If using a UNIX system:
1. At the system prompt, use the cd command to change to the appropriate
directory where the Runtime is located. For example, if it is in the
/home/sammi/bin directory:
cd /home/sammi/bin
NOTE:

This step may be eliminated if the system administrator has set up
your account so that this directory is in your PATH.

2. At the system prompt, enter the following command exactly as you see it
here (including the underline):
start_sammi
After a brief pause, the Runtime Logon Window will appear.

To logon to the Runtime
! In the Logon Window, enter your User ID and password. For this example
use an ID of “demopro” with no password. (“demopro” is a special logon
that automatically starts various data servers for demonstration purposes.)
At this time, the Runtime Command Window and the format, main_40, will
be added to your display. (The Command Window will not be used during
this demo.) The main demo screen has buttons that will lead you through
various aspects of the Sammi product. At your own pace you can progress
through the demo by selecting a topic. The demo can be exited at any time
by selecting the “Exit” button on the main demo format, main_40.
NOTE: Various displays under the heading “Industrial Applications” may display “questions marks”.
This is due to the initial state of the database that values are being read from. By simply selecting the
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“question mark” with the left mouse button, the database will be initialized
correctly and the appropriate graphics will replace the “question
mark”.
Quitting the Runtime Environment
!

From the Studio main menu, select the Exit icon. A popup box
will ask for confirmation, select “yes” if you are ready to quit at this
time.

Where to Next?
This completes the self-guided tour of Sammi. The next chapter, discusses each
component of Sammi in greater detail than previous chapters. Basic use of each
component is explained and a tutorial is provided for each to help accelerate the learning
process.
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C H A P T E R 4

The Application Development Kit (ADK)
The following sections explain how to use and interact with the Runtime
Environment, the Studio Editor and the API. Each section is followed by examples to
help illustrate various features and to help you understand how to begin building
complete dynamic graphical applications using the Sammi toolkit.

The Runtime Environment
Overview
Sammi's Runtime Environment provides the graphical framework for distributed
applications. It creates windows, loads format files, and activates the objects in the
windows. It manages the interaction between Sammi users and DDOs, and manages
network communications between Sammi's Runtime processes and application/data
servers.
Multiple, cooperating processes constitute the Sammi Runtime Environment in which
each process performs specific functions as shown in Figure 2. For example, one
process receives data and routes it to the correct formats and DDOs, another process
causes display objects to blink, while another process handles events. These processes
communicate with each other and with application/data servers using remote procedure
calls and shared memory. This distribution of tasks permits each Sammi process to
perform its job quickly and efficiently as well as handling user input events
simultaneously with data updates. In a monolithic application, the single-process
structure cannot utilize a processor’s extra CPU cycles. Because a multi-processing
approach allows functionality to be broken down into a set of separate processes, each
of which concentrates on a specialized task, CPU cycles can be used more efficiently.
Since the system often doesn’t need to wait for processing to finish, system
performance can be substantially enhanced and response time substantially reduced.
Sammi's core Runtime processes primarily exchange information with each other by
reading from and writing to shared memory. The core processes communicate with
application/data servers through the Sammi Application Programming Interface(API)
which implements Sammi's network communications.
Application/data server redundancy is provided in the RTE to provide built-in support
for automatic or manual fail-over of the primary server. This means that if the
primary server fails, continuous interaction with the user interface is supported by the
redundant server. This makes it possible for users to continue operation with the
application, reducing the risk of operational down-time.
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Sammi also utilizes a shared memory format cache which allows formats to be
dynamically loaded and displayed at run time instead of compiled and linked into the
application code. This permits hundreds or even thousands of formats to be developed
and used without any increase in memory required. The cache also allows frequently
used formats to be stored in memory and displayed without requiring any disk access
resulting in very quick display call-up.
Testing requirements are also minimized since formats are loadable binary files
instead of code fragments. Only the new format needs to be tested as opposed to the
entire application in the case of re-compiling and linking of new code.
O NC
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Working within the Runtime Environment
In general, interaction with the Runtime Environment is done through the standard
Sammi Command Window. This window is provided for your convenience. It is simply a
Sammi format created through the Studio Editor and therefore can be modified for your
own use. Specific modifications might be to include or exclude certain functionality that
your users may or may not need.
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The following illustration identifies each part of the Sammi Command Window. In
general, there are three methods of interacting with this interface:

1) Menu bar, 2) Tool bar, and 3) Command line. Each is described below.

A menu is available across the top of the command window. It specifies
the major function groups that the Sammi Runtime has under each toplevel menu item. Pull down and pull aside menu items cascade from the
top-level menu items. Mnemonics and accelerators are available on the
menu. The mnemonic for each menu item is underlined. The accelerator, if
one is defined, is shown to the right of the menu item.
A row of function icons is located below the menu bar. For the most
common functions that can be accessed from the menu, an icon is
available for quickly invoking that function. Each icon is designed to
display bubble help when it has focus. Some examples are listed below:
Icon

Name

Function

Add Window

Adds the file select dialogue to add a
window

Delete Window

Adds the file select dialogue to delete a
window

Purge

Sends a command to Sammi to purge all
formats from cache memory. This forces
Sammi to read the format from the disk the
next time it is accessed.

A Command line is available for typing in commands directly instead
of using the icons or menus. A complete listing of commands can be
found in Chapter 3-4 of the Runtime Reference.
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When working within the Runtime, particularly when prototyping and testing new
displays, there is only a small subset of commands that are needed. These commands
are explained in the following tutorial.

Runtime Environment Tutorial
To start the Runtime Environment
(This step assumes that the Runtime was exited in the previous tutorial.)

If using a WindowsNT system:
1. Double click on the Sammi icon in the Program Manager (WinNT 3.51) or
select from Start/Programs selection list (WinNT 4.0).
After a brief pause, the Runtime Logon Window will appear.

If using a UNIX system:
1. At the system prompt, use the cd command to change to the appropriate
directory where the Runtime is located. For example, if it is in the
/home/sammi/bin directory:
cd /home/sammi/bin
NOTE:

This step may be eliminated if the system administrator has set up
your account so that this directory is in your PATH.

2. At the system prompt, enter the following command exactly as you see it
here (including the underline):
start_sammi
After a brief pause, the Runtime Logon Window will appear.
To logon to the Runtime
! In the Logon Window, enter your User ID and password. For this example
us an ID of “demopro”. (“demopro” is a special logon that automatically
starts various data servers for demo purposes.)
NOTE:

The “demopro” logon should only be used for the Runtime and
NOT for the Studio Editor, this would cause the example data
servers to be started twice which could lead to unpredictable
results.

Adding formats using the Control Panel
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1. On the Studio toolbar, click on the Add Window icon.

2. From the file selection box, select the directory:
.../sammi/data_demo
3. From the file selection box, select the file:
barchart_40
The format will appear and will be dynamically updated by a data server that
was automatically started when you logged in.
Adding formats using the Command Line
1. In the Command Line, type:
add-window meter_40
The format. meter_40, will be drawn just as the format, barchart_40, was.
NOTE:

All Sammi commands can be abbreviated. For example, instead
of typing “add-window”, you could have typed “aw”.

Deleting formats using the Control Panel

1. On the Studio toolbar, click on the Delete Window icon.
2. From the file selection box, select:
barchart_40
The Runtime will delete the format, barchart_40 from the viewing area.
Deleting formats using the Command Line
1. In the Command Line, type:
delete-window meter_40
The format, meter_40, will be deleted from the viewing area.
NOTE:

As with “add-window”, the command “delete-window” can also
be abbreviated as “dw”.

Deleting formats using the window manager

! The window manager (Motif, Openlook, MSWindows) can also be used to
delete a window. The method varies for different window managers but in
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general an option menu can be accessed by pressing the right mouse button
on the format title bar and selecting “close”. Most window managers provide
a button that also allows the display to be inconized.
Purging formats using the Control Panel
! From the Studio main menu, select the Purge icon.

The purge operation will execute when the icon is pressed and will purge all
formats from cache.
Purging formats from the Command Line
! In the Command Line, type:
purge
As with the Purge icon, all formats will be removed from cache.
Using Command Line history
1. Obtain focus in the Command Line by clicking within it.
2. Use the “up” arrow key to cycle trough previous Runtime commands. When
“add-window meter_40” appears, press enter.
Using the “up” and “down” arrow keys will allow you to quickly pull up
previous commands. This will be a good time saver when building and
testing formats in the next section.
Quitting the Runtime Environment
! From the Studio main menu, select the Exit icon. A popup box will ask
for confirmation, select “yes” if you are ready to quit at this time.

This completes the Runtime tutorial. You now have all the tools needed for the next
tutorial, Building Formats with the Studio Editor. For more information regarding
the Runtime Environment refer to the Runtime Reference Guide.
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The Studio Editor
Overview
Sammi's graphical display editor is called the Studio Editor. The Studio Editor combines the familiar
look and feel of a PC drawing program with the functionality of a CAD program. It is used to
interactively create the user interface components of a system and to establish the connectivity between
the user interface components and their controlling application processes.
The top-level user interface component created with the Studio Editor is called a format. Each format
is graphically displayed in a single window. Formats contain user interface components called
Dynamic Display Objects (DDOs), and graphical primitives. DDOs are graphical objects that process
commands and events, display data, send commands, and interact with end-users. They dynamically
alter their graphical appearance based on events, commands, data values, and user interaction.
Examples of DDOs are menus, meters, text fields, plots, and equations. Although graphics primitives
such as lines, arcs and polygons are initially considered static objects, dynamic attributes can be added
for animation capabilities.
Formats, and all the objects they contain, are saved as binary images in loadable files called format
files. The Sammi Runtime Environment loads the format files into shared memory, where they are
accessible by the Runtime processes. These formats require no re-compiling or re-linking to be
displayed, therefore a format may be modified and used immediately by the Runtime Environment.
These features allow the end user, who may not have any programming experience to easily design and
modify graphical displays.
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Working with the Studio Editor
The Multiple Document Interface (MDI)
The MDI allows users to open and edit multiple formats at the same time. Previous versions of Sammi only
allowed one format to be open in the Format Editor. The Studio MDI also provides a project explorer to
access formats and an object explorer to access objects on a format.

Main Menu
Object
Explorer

Toolbars

Project
Explorer

Drawing
Area

Quick Data
Config

The main menu provides access to certain features needed to create formats and set properties.
The toolbars are located under the main menu. The toolbars are grouped by similar function.
The View menu item on the main menu is used to control which toolbars and panes are
visible. All toolbars and panes may be moved or undocked to create a custom layout. Sammi
Studio saves the layout for use in later sessions.
A command window is available for entering Sammi commands by setting the command
window to visible from the view menu of the main menu.
The Control Panel used in previous versions of Sammi is only avaiable on platforms not
supporting a MDI.
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The Drawing Area
The primary area that you will work in is the Drawing Area. This area displays the currently active
format that you are creating or editing. When creating a new format, the Drawing Area is a blank
canvas on which you can begin drawing.
The MDI allows users to open and edit multiple formats at the same time. Previous versions of Sammi only
allowed one format to be open in the Format Editor. Above each open format is a tab for easy navigation
between formats. You can use the tabs to switch between formats and can easily copy objects between
formats using copy and paste (Cntl-C and Cntl-V). The following illustration shows the Drawing Area
with multiple formats open.

Format Tab

Format Tab

Format Tab

Drawing Area
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The Project Explorer
The Project Explorer is an improved user interface for finding and opening Sammi files. The Project Explorer includes a
search feature so that you can easily search for a Sammi file by name. The Project Explorer is intended to replace the file
selection box for common file related actions.
The Project Explorer displays files located in directories defined in the $SAM2_DATAFILE environment vairable. The
files are grouped by directory and then by file type (format, component, or table). Component files are grouped as
composites, vector symbols, DDO libraries, or Images. Table files are grouped as symbol tables, DOBJ tables, or RTDA
tables.
You can double-lcik on a file to open it for editing. You can also load and unload formats using the Project Explorers
context menu.
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The Object Explorer
The Object Explorer is a user interface for finding and selecting objects in a format. You can use
the Object Explorer to find an object by name on large, complicated formats. You can select the
object from the Object Explorer and doublec lick to open the object’s properties.
The Object Explorer shows all the layers on the format and the composite (group) objects on the
format. These are referred to as “parent” objects because they contain “child” objects. You can
select a parent object to view all the child objects it contains.
The Object Search helps you refine the object list by selecting an object type or by entering a
search string for the object name.
You can use the Edit Layers button to open the Edit Layers window. The active layer for editing
is displayed in bold. You can use the Set As Active Layer button to make the currently selected
layer the active layer.

Parent
Objects
Filter by
Obbject
Type
Name
Search

Object List
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Toolbars
Toolbars provide one-access to common functions. Each toolbar can be shown/hidden using the
main menu item View toption. Each toolbar is dockable so it can undocked to create a floating
toolbar window.

File Toolbar
Edit Toolbar
View
Format Toolbar
Edit Shape Toolbar
Misc Toolbar
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The Shapes Panel
The Shapes Panel contains the basic static shapes. To draw a static object on your format, you must
select the object from the Shapes Panel.

Shapes Panel
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The DDO Tool Box
You can create dynamic objects using the pre-defined Dynamic Display Objects (DDOs) in the Tool
Box Panel. The DDOs are grouped by DDO type. You can select a DDO type to view the DDOs of that
type. Each DDO is a dynamic object with initial values set for the DDO’s properties. The Tool Box
can be customized with initial values that will be relevant for your development needs.

DDO Tool Box

The Tool Box has one object for each of the different display types available. The initial values set
for the DDO’s properties can be overridden to create a DDO exactly as you want.
The Tool Box Panel is a dockable window and can be hidden using View from the main menu.
The default layout for Studio is the Tool Box and Project Explorer on the left. To raise a panel to
the top, you select the tab for the panel.

Confidential

22 of 62

© Kinesix Software

Sammi 6.7

The Data Configuration Panel
The Data Configuration Panel displays basic data settings for the currently selected DDO.
Whne you select a DDO, the Data Configuration Panel auto-populates with the current data
setttings for that DDO.
From this panel, you can quickly view or update the data settings. You can also enter the
DDO name on this panel.

Data Configuration Panel

The panel also provides a View Tags button. The View Tags button opens a window to
select a data object from a list. The View Tags window can be customized to meet specific
application needs. The default window displays data items from a sample XML file.
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Format Properties
The properties for the format are displayed in the Format Properties window. These
properties pertain to the format as a whole but not the objects within the format. The
following illustration shows the Format Properties window.

To display the Format Properties window from the Studio main menu menu choose Edit>Format Properties.
This window is composed of six tabs. The names of all the tabs are always visible. Only
the parameters belonging in the tab that is on top are visible. You can bring a tab to the
top by clicking on its name. All the tabs in any row always stay together; bringing a tab
to the top also brings all the other tabs in its row into the first row.
There are three buttons at the bottom of this window. The Cancel button can be used to
remove the window, disregarding changes to any parameters. The Apply button can be
used to make changes to any parameters take effect; the window remains displayed on the
screen. The OK button can be used to remove the window, making any changes to any
parameters take effect at the same time.
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Basic Properties
The properties of a static object (lines, circles, polygons, etc.) are displayed in the Basic
Properties window. These properties are those of the currently-selected static object. If no
static object is selected, the properties of the “current” object are displayed. All new static
objects inherit their properties from the current object. The following illustration shows the
Basic Properties window.

To display the Basic Properties window double click on the static object or group of
objects you wish to edit.
This window is composed of five tabs. The names of all the tabs are always visible. Only
the parameters belonging in the tab that is on top are visible. You can bring a tab to the
top by clicking on its name. All the tabs in any row always stay together; bringing a tab
to the top also brings all the other tabs in its row into the first row.
There are three buttons at the bottom of the window. The Cancel button can be used to
remove the window, disregarding changes to any parameters. The Apply button can be
used to make changes to any parameters take effect; the window remains displayed on the
screen. The OK button can be used to remove the window, making any changes to any
parameters take effect at the same time.
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DDO Properties
General Properties
There are three types of DDO properties: the general properties, the display properties,
and the data properties. These are each displayed in a separate window. The general
properties of a dynamic object are displayed in the DDO Properties window. These
properties are those of the currently-selected dynamic object. If no dynamic object is
selected, the properties are grayed out. The following illustration shows the DDO
Properties window.

To display the DDO Properties window double click on the DDO that you wish to edit.
This window is composed of four tabs. The names of all the tabs are always visible. Only
the parameters belonging in the tab that is on top are visible. You can bring a tab to the
top by clicking on its name. All the tabs in any row always stay together; bringing a tab
to the top also brings all the other tabs in its row into the first row.
There are two buttons at the bottom of the window. The Cancel button can be used to
remove the window, disregarding changes to any parameters. The Save button can be
used to make any changes to any parameters take effect. The window may or may not
remain displayed on the screen, depending on the Editing Mode.
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Display Properties
There are three types of DDO properties: the general properties, the display properties,
and the data properties. These are each displayed in a separate window. The display
properties of a dynamic object are displayed in a window whose look is dependent on the
DDO’s display type. These properties are those of the currently-selected dynamic object.
If no dynamic object is selected, the properties are grayed out. The following illustration
shows an example of the Display Properties window for a meter DDO.

This window is composed of five tabs. The names of all the tabs are always visible. Only
the parameters belonging in the tab that is on top are visible. You can bring a tab to the
top by clicking on its name. All the tabs in any row always stay together; bringing a tab
to the top also brings all the other tabs in its row into the first row.
There are three buttons at the bottom of the window. The Cancel button can be used to
remove the window, disregarding changes to any parameters. The Apply button can be
used to make changes to any parameters take effect; the window remains displayed onscreen. The OK button can be used to remove the window, making any changes to any
parameters take effect at the same time.
Universal Data Access Properties
There are three types of DDO properties: the general properties, the display properties,
and the data properties. These are each displayed in a separate window. There are three
types data access: universal, local, and time.
The most interesting of these is the universal data access type. Data for a DDO will come
from an application written with the API. The data properties of a dynamic object with
universal data access are displayed in the Universal Data Access window.
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properties are those of the currently-selected dynamic object. If no dynamic object is
selected, the properties are grayed out. The following illustration shows the Universal
Data Access window.

This window is composed of three tabs. The names of all the tabs are always visible.
Only the parameters belonging in the tab that is on top are visible. A tab can be brought
to the top by clicking on its name. All the tabs in any row always stay together; bringing
a tab to the top also brings all the other tabs in its row into the first row.
There are three buttons at the bottom of the window. The Cancel button can be used to
remove the window, disregarding changes to any parameters. The Apply button can be
used to make changes to any parameters take effect; the window remains displayed on the
screen. The OK button can be used to remove the window, making any changes to any
parameters take effect at the same time.
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The Color Palette
The Color Palette is used to specify colors. The following illustration shows the Color
Palette.

The text field in the upper right shows the color setting for the selected color. In this case,
it is the window color. The window color can be changed by clicking on a color in the
palette area. Clicking on the Close button will cause the Color Palette to be removed from
the screen.
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A Studio Editor Tutorial
This section will walk you through creating your first format. The first format will contain a single
meter DDO and any static objects that you would like to add.

To start the Studio Editor
If using a WindowsNT system:

1. Double click on the Sammi icon in the Program Manager (WinNT 3.51) or
select from Start/Programs selection list (WinNT 4.0).
After a brief pause, the Runtime Logon Window will appear.
If using a UNIX system:

1.

At the system prompt, use the cd command to change to the appropriate
directory where the Studio Editor is located. For example, if the Studio
Editor is in the /home/sammi/bin directory:
cd /home/sammi/bin
NOTE:

2.

The $SAMMI enviroment variable must be set to the Sammi
installation directory. (/home/sammi in this example)

At the system prompt, enter the following command exactly as you see it
here (including the underline):
./start_studio
After a brief pause, the Logon Window will appear.

To logon to the Studio Editor
! In the Logon Window, enter your User ID and password.
NOTE:

The Studio Editor is shipped with a default User ID of root
which has no password. You can use this User ID, which has
unlimited access, unless the Sammi administrator has disabled this
User ID.

To create a new format
On the Studio Toolbar, click on the New icon.
A new format will appear in the The Drawing Area using the default size and
the default window color.
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To set the window color
1. From the Studio main menu, choose Tools->Style->Color->Palette. The Color
Palette will appear.
2. Set the Color Settings to Window.
3. Click on the desired color. The Drawing Area will immediately change to
that color.
To set the drawing color
1. If the color palette is not displayed, choose Tools->Style->Color->Palette from
the
Control Panel menu. The Color Palette window will appear.
2. Set the Color Settings to Foreground.
3. Click on a color that contrasts well with the window color that you have
chosen.
4. Click on the Cancel button to remove the window from the screen.
To create static objects

1. On the Shapes Panel, click on the Rectangle icon (or any other static
object icon).
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2.

Move the cursor to the Drawing Area and draw a rectangle. Position the
cursor where you want one corner of the rectangle. Press and hold down the
SELECT mouse button. Then, drag the rubberband box until the rectangle is
the desired size. Release the SELECT mouse button and a rectangle object is
created. You can repeat this step again to create additional rectangles

3.

On the Studio toolbar, click on the Select icon to enter Select Mode.
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To create a meter dynamic display object (DDO)
1. On the Tool Box Studio Toolbar, click on the Scale group. On the Tool Box,
click on the meter DDO icon.

2. Move the cursor to the Drawing Area; an outline of the meter will be
attached to the cursor. Position the cursor where you want the meter and
click the SELECT mouse button. The outline shows where the meter will be
displayed in the Runtime. The DDO Display window will appear.
3. Double-click on the new meter.
4. In the DDO Display window, click on Data button. The Universal Data
Access window will appear.
5. Click on the General tab in the Data Access window.
6. Select the Peer Refresh Type.
7. In the Server Name field, specify “peer_fast” as the API application that
will supply data for this object.
8. Click on the Key tab in the Data Access window.
9. In the Read field, specify “long 1 100” as the read key required for this
object.
10. In the DDO Display window, click on Save button. The dynamic object’s
definition is complete.
To preview the format in the Studio Editor
! On the Studio Toolbar, click on the View DDOs icon.
The meter appears as it will look in the Runtime, but will have an internally
generated data value (usually zero).
NOTE:

By default the DDO will initially be drawn as an outline only. An
alternative mode will display the true Runtime look and feel at all
times. To change to this mode:

1. From the Studio main menu, choose Edit->Preferences. The
Preference Properties window will appear.
2. Set the DDO Appearance to Actual.
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To make changes to an object
1. On the Studio toolbar, click on the Select icon to enter Select Mode.

2. Click on either the rectangle or the outline of the meter. When selected, the
object will highlight and adjustment handles will appear.
To move the object, position the cursor over the object’s outline (between
the adjustment handles). The cursor will change to a quad-arrow shape. Press
and hold down the SELECT mouse button, then move the object to its new
location and release the mouse button.
To resize the object, position the cursor over one of the object’s eight
adjustment handles. The cursor will change to a resize-arrow shape. Press
and hold down the SELECT mouse button while moving the handle to a new
position; release the mouse button when the object is the proper size.
3. Double-click on either the rectangle or the outline of the meter. When
selected, the object will highlight and adjustment handles will appear. A
window will also appear displaying the current properties of the object.
If the object is static, the Basic Properties window will appear. You can
make changes to the static object’s properties. Click on the OK or Apply
button for the changes to take effect in the Drawing Area.
If the object is dynamic, the DDO Properties window will appear. You can
make changes to the dynamic object’s properties. Click on Save button for
the changes to take effect in the Drawing Area.

To save changes to a format
1. On the Studio toolbar, click on the Save icon.

2. The Saveas popup will appear. Enter the name you want to save this format
as. The name is limited to 31 characters. If there is no existing format file by
that name, a new format file will be created. If there is an existing format file
by that name, a popup will appear asking you to confirm overwriting that
existing file.
The format is still open for editing and shown in the Drawing Area.
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To test a format
If the Runtime is already running, skip this step. If the Runtime is not already running,
you will need to start it.
If using a WindowsNT system:

1. Double click on the Sammi icon in the Program Manager (WinNT 3.51) or
select from Start/Programs selection list (WinNT 4.0).
After a brief pause, the Runtime Logon Window will appear.
If using a UNIX system:

1.

At the system prompt, enter the following command (including the
underline):
./start_sammi
After a brief pause, the Logon Window will appear.
NOTE:

The Runtime is shipped with a default User ID of demopro,
which has no password. You cam use this User ID, which starts
several application including peer_fast, unless the Sammi
administrator has disabled this User ID.

2. You will need to purge the Runtime if you have previously added this format
before the latest changes. Click on the Purge icon on the Runtime command
window.
3. Add the format in the Runtime by entering the following command in the
command line: aw <format_name>. The format displays; it should reflect
your latest changes. If it does not, the most common mistakes are forgetting
to save the format in the Studio Editor or forgetting to purge the Runtime.
To close a format
1. On the Studio toolbar, click on the Close icon.

2. If you have not saved changes to the format, a popup will appear asking you
to confirm that you want to dismiss the changes.
The format is no longer open for editing and the Drawing Area is blank
(although it remains the same size and has the same background color).
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To stop the Studio Editor
! From the Studio main menu, menu choose File->Exit. Confirm exit of
the
Studio Editor in the Confirm Popup.

After a brief pause, all the Studio Editor windows will disappear.
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The API
Overview
The peer applications and data servers developed with the Sammi API implement the
application-specific functionality of a Sammi system. They are the executable
programs that provide data and control logic for the overall system and for its user
interface components. They send data and commands to the Sammi Runtime
processes; and receive data, commands, and API-defined events from the Runtime
processes. A single Sammi application can consist of multiple peer applications/data
servers running on a single workstation, or running on multiple workstations
distributed across a network.
The Sammi API defines the data structures, event types, and protocol that peer
applications/data servers and the Sammi Runtime processes use to asynchronously
communicate with each other. The API consists of include files containing the API
data structure, event, and procedure declarations; and a link library containing the
procedures that implement the API protocol and network communications facilities.
The API link library is implemented in C. In addition to the standard C bindings,
optional ADA bindings for the API library are also available.
Since Sammi user interfaces are developed entirely with the Studio Editor and
managed by the Sammi Runtime processes, no embedded user interface code is
required in API peer application/data server code. Additionally, since the Sammi API
implements and manages network communications, no interprocess communications
code is required in these applications/servers. This dramatically reduces the learning
curve required to get programmers productive developing distributed graphical
applications since the Sammi API has orders of magnitude fewer functions to learn
and master.
The Sammi API uses low level ONC RPC’s for network communications to provide
the capability for various types of machines to communicate without the application
programmer having to do any data type conversions between the various machine
architectures. This allows PC’s, workstations, and servers to all seamlessly
interoperate between data and application servers and the user interface.
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Working with the API
appli cations
commands
Sammi
Runtime
Environment

Sammi commands
API

Applicat ion

data i nput
data update

The Runtime and the API communicate by sending either data or commands to each other in an
asynchronous fashion.

To coordinate this asynchronous relationship, the Runtime Environment notifies the application when
certain events happen. For example, the Runtime Environment notifies the application whenever a
format containing a dynamic object is displayed along with the parameters associated with that DDO.
In addition, the Runtime Environment will notify the application when the window (or format)
containing the DDO is deleted.
Applications using the API are created using an event driven programming paradigm. The application
waits for an event, such as an adding or deleting of a format, and then process the event. Each event
has associated information that allows the application to decide how to handle the event. For example,
an event called S2_ADD_WIN is generated by the Runtime Environment when a format containing a
DDO is displayed. The information associated with the S2_ADD_WIN event is a description of the
DDO that was added. In particular, the information contains the read key for that DDO, which was
specified in the Studio Editor when the DDO was created. This read key enables the application to
determine what data to send to the DDO.
When the format containing a DDO is deleted, another event is sent to notify the application. This
event is called an S2_DEL_WIN event. Using the S2_ADD_WIN and S2_DEL_WIN events, the
application can determine which DDOs are currently displayed. The application can then update only
those DDOs that are being displayed, rather than sending all the data on every format.
The following is a recap of the first two events described so far:
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A format containing DDOs that reference the application has
been added to the screen. The DDOs on that format have been
sent to the application.
User action: The Runtime executed a Sammi add-window
command. The format added contained a DDO that contained
a reference to the application as its logical server.

S2_DEL_WIN

A format containing one or more DDOs that reference the
application has been deleted from the screen. The DDOs on
that format have been sent to the application.
User action: The Runtime executed a delete-window
command. The format deleted contained a DDO that
contained a reference to the application as its logical server.

Confidential

38 of 62

© Kinesix Software

Getting Started Guide

Sammi 6.7

An API Tutorial
The goal of this tutorial is to provide an understanding of the basic concepts needed to construct an
application for serving data to objects displayed by the Runtime. The example code deals specifically
with the add_window and del_window events.
In the Studio Editor and Runtime tutorials a meter was created and then connected to a pre-built data
server called peer_fast. Now we will develop our own simple data server that will communicate with
the Runtime.

NOTE:

The source code for this example may not have been provided
with your copy of the Application Development Kit. If not please
contact tech support at (713) 953-8383 so that we can provide
either a soft or electronic copy. An electronic copy can be
provided via email or FTP. A hardcopy is included in Appendix
A.

Please note that this is a very quick and simple example of how to construct a Sammi API data server.
The intent is to introduce the reader to the fundamentals of API programming. More thorough
examples of API development strategies are contained in the API Guide and contributed software
subdirectory

NOTE:

Kinesix technical support is constantly updating our example
servers. For the most current examples of implementing a robust
Sammi API server or for information concerning how to develop
a server please contact Kinesix tech support.

Modify the format previously built in the Studio Editor Tutorial
1. Open format in the FE and edit (double click) the meter DDO.
2. Change logical server field to: “quick_peer”.
3. Change the Data Type field to: “float”
4. Change the rkey field to: “value0”.
5. Save this meter DDO.
6. Save the format under a new name.
Edit the example API program
1. Make working copy of directory:
cd $SAMMI/contrib
cp -r quick_peer my_peer
cd my_peer
2. Edit peer_server.c (use your favorite text editor).
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3. Note that there is no need to modify or add any new code to this example for
this tutorial. All the code that is referenced in the following sections has
already been included for your convenience.
Variable declarations (search for the line “Declarations for Example”)
! The array save_desc is used to save off a unique descriptor value for each
DDO that this server will deal communicate with.
static S2_DESC
save_desc[MAX_DFDS];
! The variable num_update keeps track of the total number of DDOs that are
currently displayed and connected to this server.
static int num_update = 0;
!

The array data_value contains the data values to be displayed. In this case
the data is static, in a “real world” application this information would be
read from some external source.
static float data_value[2] = {55.0, 66.0};

Verify event Loop coding (search for string “Example Event Loop”)
An infinite loop is constructed for checking on events from the Runtime. In
this example the server can only respond to formats being added and deleted.
After an event has been processed the function refresh_ddos() is called. In
fact since the update is asynchronous this function can be called at any time to
update DDOs with new data.
while (!quitting)
{
event = s2_get_event()
switch (event)
{
case S2_ADD_WIN: /*DDOs have been
added*/
add_window();
break;
case S2_DEL_WIN: /*DDOs have been
deleted*/
del_window();
break;
}
refresh_ddos();

/*Update DDOs*/

}
Handling add_window events (search for “Example add_window code”)
Declare array for holding array of DDO descriptors. A descriptor is a handle
for identifying a DDO. Also declare a pointer to the internal information
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! about a DDO.
DESC_T *dlist;
S2S_ELM_T *e;
! Get a descriptor for each DDO on the current format.
(void) s2_get_dfds(&dlist, &num);
! Use the descriptor to get a pointer to a data structure that contains specific
information about a DDO, such as the read key.
e = s2s_get_elm_ptr(dlist[i]);
! Loop through each DDO and Check to see if the read key is value0 (this is
the only type of DDO we recognize for this example). If we find a match
then save off the descriptor and update the total number of DDOs.
if (strcmp(e->stag.rkey,"value0") == 0)
{
save_desc[num_update] = e->stag.desc;
num_update++;
}
Handling del_window events (search for “Example del_window code”)
! Declare array for holding array of DDO descriptors. A descriptor is a handle
for identifying a DDO. Also declare a pointer to the internal information
about a DDO.
DESC_T *dlist;
S2S_ELM_T *e;
! Get a descriptor for each DDO on the current format.
(void) s2_get_dfds(&dlist, &num);
! Use the descriptor to get a pointer to a data structure that contains specific
information about a DDO, such as the read key.

e = s2s_get_elm_ptr(dlist[i]);
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! Loop through each DDO and remove this descriptor from the list created in
the add_window() routine and also decrement the number of DDOs to
update next cycle.
for (j=0; j<num_update; j++)
{
if (e->stag.desc = save_ddo[j].ddo_desc)
{
save_ddo[j] = save_ddo[num_update-1];
num_update--;
break;
}
}
Handling data updates (search for Example of refresh_dfds code)
! A structure of type S2_DATA is used to store the values that are to be used to
update a DFD with data. The data structure contains a pointer to a buffer that
contains the actual data values, as well as the DFD descriptor to be updated
and other information needed by the Runtime Environment to perform the
update.
static S2_DATA data;
! The code first checks to see if there are any DFDs displayed. If not, the code
returns and does nothing. If there are DFDs displayed, it loops over the
number of DFDs (num_update) and updates them, one at a time. For each
DFD, the code obtains a pointer to the DFDÕs structure; it does this by
passing the DFD descriptor that it had saved (save_desc[i]) to the API
function s2s_get_elm_ptr.
The code then checks an element in the DFD structure, e->stag.visible, to
determine if the DFD is visible; if it is, it will load a data buffer with as
many data values as the DFD needs. The number of data values needed by
the DFD is specified by another element in the DFD structure, e>stag.max_vals. The data buffer has a particular organization to it that the
application must follow. This organization is described in detail in the
section Overview of the API data buffer, later in this chapter.
The API provides the macro P_API_VDATA to assist the application in
managing the data buffer organization. The data buffer itself is actually
contained in the DFD structure (S2S_ELM_T), within the element e->data.
This data buffer is dynamic memory that is allocated and freed by the API.
A pointer from the S2_DATA structure to the data buffer in the
S2S_ELM_T is made by the assignment data.data = e->data. The size of the
data value is specified in data.len while the number of data values is
specified in data.num. The values that these are set to will be explained in
detail in the section Overview of the API data buffer, later in this chapter.
Finally, the element data.desc is set to the DFD descriptor that is being
updated. After the S2_DATA
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structure is loaded, the API function s2_write_vals is called to buffer the update
request.
if (num_update ==0) return;
for (i=0; i < num_update; i++)
{
e = s2s_get_elm_ptr(save_desc[i])
if (!e)
{
printf("Null pointer.\n");
return;
}
if ( e->stag.visible == TRUE )
{
for (j = 0; j < e->stag.max_vals; j++)
*P_API_VDATA(e,0,j,0,float) = (float)data_value[j];
data.data = e->data;
data.qual = NULL;
data.len = e->stag.vector_size;
data.num = e->stag.max_vals;
data.curve = 0;
data.max = 0;
data.desc = save_desc[i];
(void)s2_write_vals(data,1);
}
}
Save and compile.
! To compile:
cd $SAMMI/contrib/my_peer
make
! The result will be an executable called: my_peer
Start my_peer
! When starting a peer program an RPC number and version number must be
specified (refer to the API Guide for a safe range of RPC numbers):
my_peer -r 0x20000077 -v 1
Register your new API server with the Runtime

Confidential

43 of 62

© Kinesix Software

Getting Started Guide

Sammi 6.7

! From the Runtime Control Panel Tool Bar choose the Logical Server Table
icon. The Logical Server Table window will be displayed as shown in the
next figure.
! Add the appropriate information to the table using the tab key to move to
different columns. Hit enter when finished.
Logical Server:
RPC #:
Vers #:
Node Name:
Time Out:
Min Delay Time:
NOTE:

quick_peer
20000077
1
localhost
20
20

Notice that the logical server name is the name used in the
Logical Server field of the Universal Data Access Properties
window when editing the DDO in the Studio Editor and not the
actual name of the executible program. The Runtime uses the
RPC number and the node name to find the process.

Add your format
! In the Runtime Command Window enter the command to add your window.
aw <format name>
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The format with your meter should appear with the value 55.0 displayed. If not try
deleting the format, purging and re-adding the format.

Where to Next?
The next step is to begin working with the other features of the Runtime, Studio Editor and API. The
next chapter will direct you to the appropriate documentation for details concerning each of these
components.
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C H A P T E R 5
Summary
Congratulations! You should now be familiar enough with the basic components of
Sammi to begin working with other features of the Runtime, Studio Editor and API. For
detailed information on each of these components refer to the following documentation.
! Runtime -> Runtime Reference Guide and the System Administrators Guide
! Studio Editor -> Studio Editor Guide Volume 1 and 2
! API -> API Reference Manual
If you have additional questions call technical support at:
! phone:

(713) 953-8383

! fax:

(713) 953-8306

! Email:

tsupport@kinesix.com

Training courses are offered in Houston at the Kinesix offices and at customer sites.
Please contact your sales representative for further information on these courses.
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Appendix A: quick_peer_.c
Note that the intent of this program is to demonstrate the basic concepts of writing a
simple peer-peer program. Refer to the contrib subdirectory of your distribution for more
detailed examples. Kinesix is continually updating the contributed software, contact
technical support for the most recent releases - (713) 953-8383.
/*
*quick_peer
*
This program is completely contained in this source code file.
*
The program main appears at the top of the file. In addition
*
to the main, there are other program functions called from the
*
main. The main is structured as an event loop, monitoring
*
events from the Sammi Runtime. There is an initialization
*
program function, program functions for Sammi events,
*
a program function to handle duplicate DFD descriptors, and
*
a program function for asynchronously updating data on the
*
screen.
*
*
The following diagram shows the program structure:
*
*
main()
*
{
*
init_process();
/ Initialization function /
*
loop on Sammi events
*
process_dup();
/ Process duplicate DFDs /
*
{
*
add_window();
/ process S2_ADD_WIN /
*
del_window();
/ process S2_DEL_WIN /
*
write_data();
/ process S2_WRITE_DATA /
*
}
*
refresh_dfds();
/ asyncronous update /
*
}
*
*/
/*======================================================================*/
/*
*/
/*
INCLUDES
*/
/*
*/
/*======================================================================*/
/*
*
*/
#include <stdio.h>
#include <sys/time.h>
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#include Òs2_global.h”

/*======================================================================*/
/*
*/
/*
DEFINES
*/
/*
*/
/*======================================================================*/
/*
*
*/
#define MAX_DFDS
4 /* A random choice! */

/*======================================================================*/
/*
*/
/*
IMPORTED DATA -- DECLARATIONS
*/
/*
*/
/*======================================================================*/
/*
*
*/
extern int
optind,
opterr;
extern char
*optarg;
/*======================================================================*/
/*
*/
/*
LOCAL ROUTINE DECLARATIONS
*/
/*
*/
/*======================================================================*/
/*
*
*/
static int
init_process();
static void
add_window(),
del_window(),
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write_data(),
refresh_dfds();
/*======================================================================*/
/*
*/
/*
LOCAL DATA -- DEFINITIONS
*/
/*
*/
/*======================================================================*/
/*
*
*/
static int
quitting
= 0;
static long
que_token,
reply_token;
static long
update_dfds;
static char
*opts

= ÒD:Q:”;

/*======================================================================*/
/*
*/
/*
GLOBAL DATA -- DEFINITIONS
*/
/*
*/
/*======================================================================*/
/*
*
*/
unsigned long
debug_level
= 1,
queing_on
= 1;
/*
* Declare an array to save the descriptor for each dfd that is
* going to be affected by refresh_dfds(). Declare a counter to
* keep track of the number of dfds and initialize two arrays
* with data to refresh the dfds.
*/
static S2_DESC
save_desc[MAX_DFDS];

static in
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num_update = 0;
static float
data_value[2] = {55.0, 66.0};

/*======================================================================*/
/*
*/
/*
MAIN() ROUTINE
*/
/*
*/
/*======================================================================*/
/*
*
*/
main(argc, argv)
int argc;
char **argv;
{
int
event,
/* Declare an event */
api_argc;
char
**api_argv;
static struct timeval
timeout = {0, 100}; /* Set an initial timeout */

/*
* Initialize the Sammi connection and exit if it fails.
*/
if ( s2_stripargs(&argc, &argv, &api_argc, &api_argv) < 0 )
{
fprintf(stderr,”Error returned from s2_stripargs\n”);
exit(13);
}
if ( s2_init(api_argc, api_argv) == FAILURE )
exit(-1);
/*
* Call the application-defined init and exit if failure returned.
*/

Confidential

50 of 62

© Kinesix Software

Getting Started Guide

Sammi 6.7

if ( init_process(argc, argv, &timeout) == FAILURE )
{
s2_exit();
exit(-1);
}
/*
* Enter the event loop. This loop is exited when the application
* sets the external variable quitting to TRUE
*/
while ( ! quitting )
{
update_dfds = TRUE;
event = s2_get_event( &timeout );
switch( event )
{
case S2_TIMEOUT:
break;
case S2_ADD_WIN:
add_window();
break;
case S2_DEL_WIN:
del_window();
break;
case S2_WRITE_DATA:
write_data();
break;
}

/* end switch (event) */

/*
* Do any application-specific data update
*/
if (update_dfds) refresh_dfds();
}
/* end while */
/*
* Terminate the Sammi connection and clean up the API
*/
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/* main */

/*======================================================================*/
/*
*/
/*
LOCAL ROUTINES
*/
/*
*/
/*======================================================================*/
/*
*
*/
/*----------------------------------------------------------------------*/
/*
*/
/* Init_process is called by the main application driver. The function */
/* performs any application specific initialization. This could
*/
/* involve processing command line arguments specific to your app.
*/
/*
*/
/*----------------------------------------------------------------------*/
/*
*
*/
static int
init_process(argc, argv, timeout)
int
argc; char
**argv; struct timeval
*timeout;
{
int
i;

optind = 1; /* Set the counter to 1 to get the first arg */
opterr = 0; /* Suppress error messages */
while ( (i = getopt(argc, argv, opts)) != -1 )
{
switch ( i )
{
case “D”:
/****************************************/
/*
*/
/* Set my variable or flag for the */
/* “-D” option here.
*/
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/*
*/
/****************************************/
/*
* The following is typical code -- you may want to
* change it!
*/
debug_level |= (1 << atoi(optarg));
break;
case “Q”:
/****************************************/
/*
*/
/* Set my variable or flag for the */
/* “-Q” option here, and get the
*/
/* numeric value that should follow. */
/*
*/
/****************************************/
/*
* The following is typical code -- you may want to
* change it!
*/
queing_on |= (1 << atoi(optarg));
/*
* Detect optarg == 0 -> turn queing OFF.
*/
if ( queing_on & 1 )
queing_on = 0;
break;
/*************************************************/
/*
*/
/* A D D I T I O N A L A R G U M E N T S */
/*
CODE GOES HERE
*/
/*
*/
/*************************************************/
default : /* Put any default processing here */
break;
}/* end switch */
}/* end while */

Confidential

53 of 62

© Kinesix Software

Getting Started Guide

Sammi 6.7

/*************************************************/
/*
*/
/* Y O U R I N I T I A L I Z A T I O N
*/
/*
CODE GOES HERE
*/
/*
*/
/*************************************************/
return (SUCCESS);
}

/* End of init_process */

/*----------------------------------------------------------------------*/
/*
*/
/* add_window() is called in response to S2_ADD_WIN events.
*/
/* The function can be used to set internal variables so that the
*/
/* application remembers which DFDs are on the screen. It gets the
*/
/* list of DFDs that have been added, then processes each DFD in the */
/* list.
/*
*/
/*----------------------------------------------------------------------*/
/*
*
*/
static void
add_window()
{
int
i,
num;
DESC_T
*dlist;
S2S_ELM_T
*e;

if ( debug_level )
printf(“Processing add_win event.\n”);
/*
* get the list of dfds
*/
(void) s2_get_dfds(&dlist, &num);

for ( i = 0; i < num; i++ )
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{
/*
* Get the elm pointer and check for errors
*/
e = s2s_get_elm_ptr(dlist[i]);
/*
* Check to make sure there was a data structure;
* if there was not, return with a non-zero error
* code.
*/
if (!e)
{
/***************************/
/* write out error message */
/***************************/
return;
}
/****************************************************************/
/*
*/
/*
YOUR CODE GOES HERE
*/
/*
*/
/* Add the appropriate dfd description from the format to our*/
/* dfd description list for updating through refresh_dfds(). */
/* Also, update the number of dfds.
*/
/*
*/
/****************************************************************/
if (strcmp(e->stag.rkey,”value0”) == 0)
{
save_desc[num_update] = e->stag.desc;
num_update++;
}
}

/* end for loop */

if (dlist)
free(dlist);
return;
}

/* add_window */

/*----------------------------------------------------------------------*/
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/*
*/
/* del_window() is called in response to S2_DEL_WIN events.
*/
/* This function gets the list of DFDs that have been deleted
*/
/* and processes each DFD in the list. It can be used to clear
*/
/* internal variables so that it forgets the DFD was on the screen. */
/*
*/
/*----------------------------------------------------------------------*/
/*
*
*/
static void
del_window()
{
int
i, j,
num;
DESC_T
*dlist;
S2S_ELM_T
*e;

if ( debug_level)
printf(“Processing del_win event.\n”);
/*
* get the list of dfds
*/
(void) s2_get_dfds(&dlist, &num);
for (i = 0; i < num; i++)
{
/*
* Get the elm pointer and check for errors
*/
e = s2s_get_elm_ptr(dlist[i]);
/*
* Check to make sure there was a data structure;
* if there was not, return with a non-zero error
* code.
*/
if (!e)
{
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/**********************************************/
/* write out your error message here
*/
/**********************************************/
return;
}
/****************************************************************/
/*
*/
/*
YOUR CODE GOES HERE
*/
/*
*/
/*
*/
/* Delete the appropriate dfd description from the
*/
/* dfd descriptor list and decrement number of DDOs
*/
/*
*/
/****************************************************************/
for (j=0; j<num_update; j++)
{
if (e->stag.desc == save_desc[j])
{
save_desc[j] = save_desc[num_update-1];
num_update--;
break;
}
}
}
/* end for loop */
if ( dlist )
free(dlist);
return;
}

/* del_window */

/*----------------------------------------------------------------------*/
/*
*/
/* write_data() is called in response to S2_WRITE_DATA events.
*/
/* This function uses s2_get_vals to retrieve a pointer to the
*/
/* UNI_WRITE_T structure. The data field of this structure contains */
/* the new data and should be stored in the appropriate local variable. */
/*
*/
/*----------------------------------------------------------------------*/
/*
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*
*/
static void
write_data()
{
int
i, j,
num;
DESC_T
*dlist;
S2S_ELM_T
*e;
UNI_WRITE_T
*data;

if ( debug_level )
printf(“Processing write_data event.\n”);
/*
* get the list of dfds
*/
(void) s2_get_dfds(&dlist, &num);
for ( i = 0; i < num; i++ )
{
/*
* Get the elm pointer and check for errors.
*/
e = s2s_get_elm_ptr(dlist[i]);
/*
* Check to make sure there was a data structure;
* if there was not, return with a non-zero error
* code.
*/
if ( ! e )
{
/*********************************************/
/* write out your error message here
*/
/*********************************************/
return;
}
data = s2_get_vals(dlist[i]);
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/****************************************************************/
/*
*/
/*
YOUR CODE GOES HERE!
*/
/*
*/
/* Use the elm pointer to check the read key in order to
*/
/* identify the DFD.
*/
/*
*/
/* In order to determine how many pieces of data was sent and */
/* what their offsets are in the dataset, you must look at
*/
/* “num” and “offset” in the UNI_WRITE_T structure.
*/
/*
*/
/****************************************************************/
if (strcmp(e->stag.rkey,”value0”)==0)
{
for (j=0; j<e->write->num; j++)
{
data_value[e->write->elm[j].offset] =
*P_WRITE_VDATA(e,j,0,float);
}
}
}
/* end for loop */
if ( dlist )
free(dlist);
return;
}

/* write_data */

/*----------------------------------------------------------------------*/
/*
*/
/* refresh_dfds() is called once each time the event loop cycles,
*/
/* giving the application a chance to update DFD data. It is up to the */
/* application to determine when (and if) data is refreshed. Data to */
/* be sent to a DFD is loaded into the S2_DATA structure and then
*/
/* s2_write_vals() is called. s2_flush_vals() is called next to flush */
/* the buffered data to the DFD.
*/
/*
*/
/*----------------------------------------------------------------------*/
/*
*
*/
static void
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refresh_dfds()
{
int
i,
j,
k,
num_errs,
err_code;
static S2_DATA
data;
static S2S_ELM_T
*e;
static UNI_ERR_T
*errs;

/************************************************************************/
/*
*/
/* Y O U R C O D E G O E S H E R E !
*/
/*
*/
/* If no DFDs are flagged as needing to be updated, then return.
*/
/* Then loop through each dfd that we know about getting ptr to
*/
/* the S2S_ELM_T structure. Check that each dfd is visible, if it
*/
/* is then stuff data into the S2_DATA structure.
*/
/*
*/
if (num_update == 0) return;
for (i = 0; i < num_update; i++)
{
e = s2s_get_elm_ptr(save_desc[i]);
if ( !e )
{
printf(“Null pointer.\n”);
return;
}
if ( e->stag.visible == TRUE )
{
for (j = 0; j < e->stag.max_vals; j++)
*P_API_VDATA(e,0,j,0,float) = (float)data_value[j];
data.data = e->data;
data.qual = NULL;
data.len = e->stag.vector_size;
data.num = e->stag.max_vals;
data.curve = 0;
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data.max = 0;
data.desc = save_desc[i];
(void)s2_write_vals(&data,1);
}

}
/* Flush data from buffer */
if ( queing_on )
{
err_code = s2_que_vals(&que_token, 0, 0);
/*************************************************/
/* Your special que handling goes here,
*/
/* if any -- e.g., setup for subsequent S2_REPLY */
/* event w.r.t. que_token.
*/
/*************************************************/
}
else
{
err_code = s2_flush_vals();
}
if ( err_code )
{
s2_get_errs(&num_errs, &errs);
if ( debug_level )
{
for (i=0; i< num_errs; i++)
{
e = s2s_get_elm_ptr(errs[i].desc);
printf(“ data update for DFD Read Key %s failed”,
e->stag.rkey);
printf(“ with error code %d\n”, errs[i].error);
}
}
/****************************************************************/
/* s2_get_errs returns a list of DFDs that were flushed and */
/* their corresponding error codes. If the error indicates that */
/* the DFD was not written to successfully, then that DFD must */
/* be written to again.
*/
/*
*/
/* A good method for handling these error codes is to
*/
/* maintain a state variable for each DFD indicating whether */
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/* it needs updating or not. If a DFD is not successfully
*/
/* flushed (e.g. error from s2_flush_vals) then mark it as */
/* needing to be updated again.
*/
/*
*/
/* Note: Returned error codes for an enqeued request
*/
/*
(s2_que_vals()) are handled using s2_get_reply_status */
/*
in the event loop (for the S2_REPLY event.
*/
/****************************************************************/
}
return;
}
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Appendix B: Starting Sammi in Chinese and
Korean
Both the Sammi Studio Editor and Runtime can be run with formats using Chinese and
Korean fonts.
To start the Studio Editor, enter the following in a command line:

start_fe_ZH (Chinese)
start_fe_KR (Korean)

To start the Sammi Runtime, enter the following in a command line:

start_sammi_ZH (Chinese)
start_sammi_KR (Korean)

To view the Sammi demo formats, start the Sammi Runtime and in the logon
window enter the following appropriate username with no password:
demo_ZH (Chinese)
demo_KR (Korean)
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